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For safety, please read this manual carefully before you use this product and keep it handy
for future reference.



Introduction
To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information in the Copy Reference before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-
porated.

Appletalk, Apple, Macintosh and Mac are registered trademarks of Apple Computer, Incorporated.
Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.
Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.
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Installable Options

The following options are available.

< Input Paper Device
¢ Large Capacity Tray (LCT)
* Paper tray unit

< Output Paper Device
¢ Internal tray 2 (1 bin tray)
¢ Finisher 1000
¢ Finisher 2250
e Booklet Finisher

Setting Up Options

To use the installed options correctly, you have to first set up the printer driver.
If the options are not recognized, you cannot use them even though they are
physically installed on the printer. The method of setting up the printer driver
may differ depending on the operating system.

% Windows
You can set up any of the options with the following tabs.

Operating System Tab Name

Windows 95/98/Me [Accessories] tab

Windows 2000/XP [Device Settings] tab

Windows NT 4.0 [Device Settings] tab
& Note

O You should access the printer driver from Windows to set up options. You
cannot set up options when accessing the printer driver from an applica-
tion.
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? Limitation

O If your system is Windows 2000 or Windows XP Professional, changing
the printer driver setting requires Manage Printers permission. Members
of the Administrators and Power Users groups have Manage Printers per-
mission by default. When you change the settings of the printer driver, log
on under Manage Printers permission.

O If your system is Windows NT 4.0, changing the printer driver setting re-
quires Full Control access permission. Members of the Administrators,
Server Operators, Print Operators, and Power Users groups have Full Con-
trol permission by default. When you change the settings of the printer
driver, log on under Full Control permission.

O If you use Adobe Page Maker 6.0, 6.5 or 7.0 with Windows 95/98/Me,
Windows 2000 or Windows NT 4.0, you have to set up options in the Ado-
be PageMaker's print dialog box.

% Mac OS
You can set up all of the options in the [Chooser] dialog box.
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Printing a Document

This section describes how to print a document from an application.

< Paper Source
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Paper] tab

Windows 2000/ XP [Paper/Quality] tab

Windows NT 4.0 [Page Setup] tab

Mac OS [General] in the print dialog box
Mac OS X [Paper Feed] in the print dialog box.

« Destination Tray
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Destination] on the [Paper] tab

Windows 2000/XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced] tab

Mac OS [Printer Specific Options] in the print dialog box

Mac OS X [Printer Features] in the print dialog box.

<+ Duplex Printing
Use this function to select “Duplex Printing”.

? Limitation

O To use this function, the duplex unit must be installed on the printer.
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Duplex] on the [Setup] tab

Windows 2000/ XP [Print on Both Sides (Duplex)] on the [Layout] tab
Windows NT 4.0 [Page Setup] tab

Mac OS [Print on Both Sides] on [Layout] in the print dialog box
Mac OS X [Print on both Sides] on [Duplex] in the print dialog box.
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% Collate
Use this function to enable collation. With this, the printer can efficiently print
collated sets of multiple-page documents.

? Limitation

O If you use Windows 2000/ XP, Mac OS or Mac OS X, make sure that the fol-
lowing check boxes have not been selected.
e Windows 2000/ XP
The [Collated] check box on [Paper/Output] on [Advanced...] on the [Pa-
per/Quality] tab
e Mac OS
The [Collate] check box in the print dialog box.
e MacOS X
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Collate] on the [Setup] tab

Windows 2000/XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced...] tab

Mac OS [Printer Specific Options] in the print dialog box

Mac OS X [Printer Feature] in the printer dialog box.

< Edge Smoothing
Use this function to improve the print quality of text. Indentations in curved
lines are automatically smoothed to produce a cleaner appearance.

? Limitation

O When “Edge Smoothing” is selected, “Toner Saving” is not enabled.

O As this function is for improving the quality of printed text, set it to OFF
when printing pictures and half tone data.

@ Note

O This function is for improving the quality of printed text. Do not use for
images.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Edge Smoothing] on the [Print Quality] tab

Windows 2000/ XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced] tab

Mac OS [Printer Specific Options] in the print dialog box

Mac OS X [Printer Feature] in the printer dialog box.
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« Toner Saving
Use this function to reduce the amount of toner used when printing.

? Limitation

O When “Toner Saving” is selected, “Edge Smoothing” is not enabled.

@ Note

O While this will increase the life of the toner, the output will appear slightly
lighter.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Toner Saving] on the [Print Quality] tab
Windows 2000/ XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab
Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced] tab
Mac OS [Printer Specific Options] in the print dialog box
Mac OS X [Printer Feature] in the printer dialog box.
< Staple
Use this function to staple sheets of printed paper together.
o

e Limitation

O When stapling, use the finisher option. See Copy Reference or Printer/Scan-
ner Unit Type 2045 Printer Reference 2.

& Note

O The stapling location might differ depending on the direction of the paper
set in the printer and the direction of the data to be printed. For details, see
“Staple and Punch”, Printer/Scanner Unit Type 2045 Printer Reference 2.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Staple] on the [Setup] tab

Windows 2000/XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced] tab.

Mac OS [Printer Specific Options] in the print dialog box

Mac OS X [Printer Feature] in the printer dialog box.
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Punch
Use this function to make punch holes in the printed documents.

? Limitation

O When making punch holes, use the finisher option. See Copy Reference or
Printer Reference 2.

@ Note

O The available punch positions and the number of punch holes will change
depending on the type of finisher, the original's orientation, and the print-
ing paper size and orientation. For details, see "Staple and Punch", Print-
er/Scanner Unit Type 2045 Printer Reference 2.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Punch] on the [Setup] tab

Windows 2000/XP [Printer Features] on [Advanced...] on the [Paper/Quality] or
[Layout] tab

Windows NT 4.0 [Printer Features] on [Document Options] on the [Ad-
vanced] tab.

Mac OS [Printer Specific Options] in the print dialog box

Mac OS X [Printer Feature] in the printer dialog box.

Sample Print

Use this function to make only one set of a multiple print job, and if the result
is satisfactory, the remaining sets can be printed out from the machine's con-
trol panel.

? Limitation

O Applications, like PageMaker, which use original drivers do not work with
this function.

@ Note

O The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-
acters.

O Entering the “User ID” helps you to distinguish the print job from others.
The following table shows the tabs or menus where you can select this func-
tion.

Windows 95/98/Me [Job Type] on the [Setup] tab
Windows 2000/XP [Job Type] on the [Job/Log] tab
Windows NT 4.0 [Job Type] on the [Job/Log] tab
Mac OS [Job/Log] in the print dialog box
Mac OS X This function is not available.
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Locked Print

Use this function to save documents in the machine's hard disk using a pass-
word, and then print them as you want.

? Limitation

O Applications, like PageMaker, which use original drivers do not work with
this function.

& Note

O The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-
acters. The “Password” must be four digits.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Job Type] on the [Setup] tab

Windows 2000/XP [Job Type] on the [Job/Log] tab

Windows NT 4.0 [Job Type] on the [Job/Log] tab

Mac OS [Job/Log] in the print dialog box

Mac OS X This function is not available.
Document Server

Use this function to store the machine's hard disk documents that you want
to print as well as documents you might want to later combine or process for
printing. For more information about the “Document Server” function, see
“Accessing the Document Server”, Printer/Scanner Unit Type 2045 Printer Ref-
erence 2.

? Limitation

O Applications, like PageMaker, which use original drivers do not work with
this function.

& Note

O An optional hard disk drive is required to use the Document Server func-
tion.

The following table shows the tabs or menus where you can select this func-

tion.

Windows 95/98/Me [Job Type] on the [Setup] tab
Windows 2000/ XP [Job Type] on the [Job/Log] tab
Windows NT 4.0 [Job Type] on the [Job/Log] tab
Mac OS [Job/Log] in the print dialog box
Mac OS X This function is not available.
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Toner Saving, Edge Smoothing

Follow the procedures below to print a document using “Toner Saving” or
“Edge Smoothing”.

Windows 95/98/Me

ﬂ From an application, select [Print] from the file menu.

The print dialog box appears.
ﬂ Open the Printer Properties.
B Click the [Print Quality] tab.
ﬂ Select the function you want to use.

B After making all of the settings you want, click [OK] to close the Printer
Properties.

E Start printing from the application's print dialog box.

Windows 2000/XP

ﬂ From an application, select [Print] from the file menu.

The print dialog box appears.
g Open the Printer Properties.

& Note

O Under Windows 2000, the Printer Properties has already appeared together
with the print dialog box. Under Windows XP, open the Printer Preferences.

B Click to select the [Paper/Quality] tab.

O ciick [Advanced...].
[Advanced Options] appears.

B From [Document Options], select [Printer Features].
E Click [Print Mode] to select the function you want to use.

ﬂ After making all of the settings you want, click [OK] to close the Printer
Properties.

& Note

O Under Windows 2000, you do not need to close the Printer Properties. Un-
der Windows XP, close the Printer Preferences.

8 Start printing from the application's print dialog box.
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Windows NT 4.0

ﬂ From an application, select [Print] from the file menu.

The print dialog box appears.
g Open the Printer Properties.
B Click the [Advanced] tab.
ﬂ From [Document Options], select [Printer Features].
B Click [Print Mode] to select the function you want to use.

B After making all of the settings you want, click [OK] to close the Printer
Properties.

ﬂ Start printing from the application's print dialog box.

Mac OS/Mac OS X

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g From the pop-up menu, select [Printer Specific Options].

& Note
O Under Mac OS X, select [Printer Features].

B Click [Print Mode] to select the function you want to use.

ﬂ After making all of the settings you want, click [Print].

Staple

Follow the procedures below to print a document using the “Staple” functions.

Windows 95/ 98/ Me

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.
B Click the [Setup] tab.

ﬂ Make the settings you want in [Staple], and click [OK] to close the Printer
Properties.

B Start printing from the application's print dialog box.
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Windows 2000/XP

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g Open the Printer Properties.

& Note

O Under Windows 2000, the Printer Properties has already appeared togeth-
er with the print dialog box. Under Windows XP, open the Printer Prefer-
ences.

B Click to select the [Paper/Quality] tab.

O ciick [Advanced...].
The [Advanced Options] dialog box appears.

B Click to select the function you want to use and select the appropriate set-
ting.

B After making all of the settings you want, click [OK] to close the Printer
Properties.

& Note

O Under Windows 2000, you do not need to close the Printer Properties. Un-
der Windows XP, close the Printer Preferences.

ﬂ Start printing from the application's print dialog box.

Windows NT 4.0

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.

B Click the [Advanced] tab.

ﬂ From [Document Options], select [Printer Features].
B Click [Staple] to select the function you want.

B After making all of the settings you want, click [OK] to close the Printer
Properties.

ﬂ Start printing from the application's print dialog box.
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Mac OS/Mac OS X

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g From the pop-up menu, select [Printer Specific Options].

& Note
O Under Mac OS X, select [Printer Features].

B Choose the location to staple from the pop-up menu in [Staple].

ﬂ After making all of the settings you want, click [Print].

Punch

Follow the procedures below to print a document using the “Punch” functions.

Windows 95/ 98/ Me

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.
B Click the [Setup] tab.

ﬂ Make the settings you want in [Punch], and click [OK] to close the Printer
Properties.

B Start printing from the application's print dialog box.

Windows 2000/XP

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g Open the Printer Properties.

& Note

O Under Windows 2000, the Printer Properties has already appeared togeth-
er with the print dialog box. Under Windows XP, open the Printer Prefer-
ences.

B Click to select the [Paper/Quality] tab.

11
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O ciick [Advanced...].
The [Advanced Options] dialog box appears.

B Click to select the function you want to use and select the appropriate set-
ting.

E After making all of the settings you want, click [OK] to close the Printer
Properties.

@ Note

O Under Windows 2000, you do not need to close the Printer Properties. Un-
der Windows XP, close the Printer Preferences.

ﬂ Start printing from the application's print dialog box.

Windows NT 4.0

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.

B Click the [Advanced] tab.

ﬂ From [Document Options], select [Printer Features].
B Click [Punch] to select the function you want.

B After making all of the settings you want, click [OK] to close the Printer
Properties.

ﬂ Start printing from the application's print dialog box.

Mac OS/Mac OS X

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g From the pop-up menu, select [Printer Specific Options].

& Note
O Under Mac OS X, select [Printer Features].

B Choose the location to punch from the pop-up menu in [Punch].

ﬂ After making all of the settings you want, click [Print].
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Sample Print

Follow the procedures below to print a document using the “Sample Print”
function.

Windows 95/98/Me

& Note

O If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If the collate option is selected in the application print
dialog box, more prints than intended may be printed.

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.

B Click to select the [Setup] tab.

O select [Sample Print] in the [Job Type] box.
B Click [Details].

B Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters.

& Note
O This is used to identify the user associated with a job.

O The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-
acters.

1 click [0k,
B Click [OK] to close the Printer Properties.

g Set the number of copies to more than 2 and start printing from the appli-
cation's print dialog box.

The sample print job is sent to the machine and one set is printed.

[m Check the printed output to make sure that the settings are correct.
If the settings are correct, go to step ff] to print the remaining sets.
If you want to delete the saved job, see p.19 “Deleting a Sample Print File”.

@ on the machine's control panel, press the [Printer] key to display the Printer
screen.

13
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[E Press [View Sample Print jobs].
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The following will also be displayed

* User ID : The User ID set up by the printer driver.

¢ Date/Time : The date and time when the job was sent from the computer.
¢ Qty. : The number of remaining sets.

[B Press [APrev.] or [VNext.] to scroll the files to the one you want to print.

[ﬂ Select the file you want to print by pressing it.
¢ If you want to cancel the sample print file, press it again.
* You can select only one file at a time.

[B Press [Change Set Qty.] to change the number of sets to be printed.

Sample Print jobs (Offline)

5555 05/22 13:13 1

3338 [NENED [ Change Set Gty

IENCEET N

If you do not want to change the set quantity then proceed to step .

m Enter the new number of sets using the number keys and press [OK].
The screen returns to the file list screen.
& Note
O You can enter up to 999 sets.
O Press [Clear] to correct any entry mistakes.
O If you want to cancel [Change Set Qty.], press [Cancel].

m Press [Print].

The print confirmation screen is displayed.
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m Press [Yes].
The remaining sets are printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.

Windows 2000/XP, Windows NT 4.0

@ Note

O If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If the collate option is selected from the application print
dialog box, more prints than intended may be printed.

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g Open the Printer Properties.

& Note

O Under Windows 2000, the Printer Properties has already appeared togeth-
er with the print dialog box. Under Windows XP, open the Printer Prefer-
ences.

B Click to select the [JobiLog] tab.
ﬂ Select [Sample Print] in the [Job Type] box.

B Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters.

& Note
O This is used to identify the user associated with a job.

O The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-
acters.
B Click [OK] to close the Printer Properties.
ﬂ Set the number of copies to more than 2 and start printing from the appli-
cation's print dialog box.

The sample print job is sent to the machine and one set is printed.

8 Check the printed output to make sure that the settings are correct.
If the settings are correct, go to step [] to print the remaining sets.
If you want to delete the saved job, see p.19 “Deleting a Sample Print File”.

15
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g On the machine's control panel, press the [Printer] key to display the Printer
screen.

[E Press [View Sample Print jobs].
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The following will also be displayed:

* User ID : The User ID set up by the printer driver.

¢ Date/Time : The date and time when the job was sent from the computer.
¢ Qty. : The number of remaining sets.

m Press [APrev.] or [VNext.] to scroll the files to the one you want to print.

m Select the file you want to print by pressing it.
¢ If you want to cancel the sample print file, press it again.

* You can select only one file at a time.

[B Press [Change Set Qty.] to change the number of sets to be printed.

Sample Print jobs (Offline)

User ID Date/Time aty.

5555 05/22 13:13 1

IEE 11

If you do not want to change the set quantity then proceed to step {B.

m Enter the new number of sets using the number keys and press [OK].
The screen returns to the file list screen.

& Note

O You can enter up to 999 sets.

O Press [Clear] to correct any entry mistakes.

O If you want to cancel [Change Set Qty.], press [Cancel].

[B Press [Print].

The print confirmation screen is displayed.
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m Press [Yes].
The remaining sets are printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.

Mac OS/Mac OS X

? Limitation

O If you use Mac OS X, this functions cannot be used.

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ From the pop-up menu, select [Job/Log].
B From the [Job Type] pop-up menu, select the appropriate setting.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters.

& Note
O This is used to identify the user associated with a job.

B Set the number of copies to more than 2 and click [Print].
The sample print job is sent to the machine and one set is printed.

E Check the printed output to make sure that the settings are correct.
If the settings are correct, go to step [ to print the remaining sets.
If you want to delete the saved job, see p.19 “Deleting a Sample Print File”.

ﬂ On the machine's control panel, press the [Printer] key to display the Printer
screen.

B Press [View Sample Print jobs].

L rPpe Tyt (TE Jl28 O[3 Ola8 O] & ()
Ad [ A3 |81 8414 | 811

W Sample Print L ocked Print

----- . [ Ve Sarple i jobs 11 iew Locked Prirt obs ]
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A list of the sample print files stored on the machine is displayed.

Sample Print jobs (Offline)

User ID Date/Time Gy,

[ [ o520 1319 T

i
[ 3sse IR [
L]

[ | os/zz 13:15

The following will also be displayed

* User ID : The User ID set up by the printer driver.

e Date/Time : The date and time when the job was sent from the computer.
e Qty.: The number of remaining sets.

g Press [APrev.] or [VNext.] to scroll the files to the one you want to print.

[m Select the file you want to print by pressing it.
¢ If you want to cancel the sample print file, press it again.
* You can select only one file at a time.

ﬂ] Press [Change Set Qty.] to change the number of sets to be printed.

User ID Date/Time dty

[ osss IR [
i 05727 13116

If you do not want to change the set quantity then proceed to step {B.

m Enter the new number of sets using the number keys and press [OK].
The screen returns to the file list screen.

& Note
O You can enter up to 999 sets.

O Press [Clear] to correct any entry mistakes.
O If you want to cancel [Change Set Qty.], press [Cancel].

[B Press [Print].

The print confirmation screen is displayed.

[ press [Yes].
The remaining sets are printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.
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Deleting a Sample Print File

If the printed document is not what you expected, you can delete the sample
print file.

ﬂ On the machine's control panel, press the [Printer] key to display the Printer
screen.

ﬂ Press [View Sample Print jobs].
A list of the sample print files stored in the machine is displayed.

B Select the file you want to delete by pressing it.

& Note
(3 Press [APrev.] or [¥Next.] to scroll the list.

O To cancel a selection, press the highlighted file again.
O Only one file can be selected at a time.

0 press [Delete].
The Delete Confirmation screen will be displayed.

B Press [Yes] to delete the file.
After the file has been deleted the screen will return to the Printer screen.

& Note
O If you do not want to delete the file, press [No].

Locked Print

Follow the procedures below to print a document using the “Locked Print” func-
tion.

Windows 95/98/Me

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g Open the Printer Properties.

B Click to select the [Setup] tab.

ﬂ Select [Locked Print] in the [Job Type] box.
B ciick [Details].
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B Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a four-digits password in [Password].

& Note
O This is used to identify the user associated with a job.

W crick [0k,
B Click [OK] to apply the settings you made.

g After making all of the settings you want, click [OK] to close the print dialog
box.

The document file is saved in the machine.
If you want to print this document, go to step .
If you want to delete this document, see p.25 “Deleting a Locked Print File”.

[ on the machine's control panel, press the [Printer] key to display the Printer
screen.

I]] Press [View Locked Print jobs].

| > Paper Tray Stus 1@ D28 ofse of4ae o L[
Ad [ A3 [8ax11|8%x14 | 8%x11

~ I Sample Print Locked Print

View Sample Print jobs 1| Wiew Lacked Prin jobs |

Select files.
User ID Date/Time dty

[ osss IR

3333 05/22 13:20 1

The date and time when the job was sent from the computer, as well as the
User ID is displayed.

m Select the file you want to print by pressing it.

& Note
(3 Press [APrev.] or [¥Next.] to scroll the list.

O To cancel a selection, press the highlighted file again.
O Only one file can be selected at a time.
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[B Press [Print].
The password screen is displayed.

[ﬂ Enter the password using the number keys, and then press [OK].
The print confirmation screen is displayed.

& Note

O The confirmation screen will reappear when the password has not been en-
tered correctly. Press [OK] to enter the password again.

[B Press [Yes].
The locked print file is printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.

O If printing is stopped by pressing [Job Reset] after printing has started, the
file will be deleted.

Windows 2000/XP, Windows NT 4.0

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.

& Note

O Under Windows 2000, the Printer Properties has already appeared togeth-
er with the print dialog box. Under Windows XP, open the Printer Prefer-
ences.

B Click to select the [JobiLog] tab.
ﬂ Select [Locked Print] in the [Job Type] box.

B Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a four-digits password in [Password].

& Note
O This is used to identify the user associated with a job.

2]
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B Click [OK] to apply the settings you made.
ﬂ After making all of the settings you want, click [OK] to close the print dialog
box.
The document file is saved in the machine.
If you want to print this document, go to step f}.
If you want to delete this document, see p.25 “Deleting a Locked Print File”.

B on the machine's control panel, press the [ Printer] key to display the Printer
screen.

E) press [View Locked Print jobs].

L rPpe Tyt (TE Jl28 O[3 Ola8 O] & ()
Ad [ A3 |81 8414 | 811

W Sample Print L ocked Print

| View Sample Print jobs. 11 Wiew Locked Prift jobs

User ID Date/Time Gy,

[ [IKEREA] T

i
[ 3sse [ o522 18:20 [
L]

[ | os/z 130

The date and time when the job was sent from the computer, as well as the
User ID is displayed.

m Select the file you want to print by pressing it.

& Note

(O Press [APrev.] or [VNext.] to scroll the list.

O To cancel a selection, press the highlighted file again.
O Only one file can be selected at a time.

m Press [Print].
The password screen is displayed.

@ Enter the password with the number Keys, then press [OK]
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m Enter the password using the number keys, and then press [OK].

The print confirmation screen is displayed.

@ Note

O The confirmation screen will reappear when the password has not been en-
tered correctly. Press [OK] to enter the password again.

B press [Yes].
The locked print file is printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.

O If printing is stopped by pressing [Job Reset] after printing has started, the
file will be deleted.

Mac OS/Mac OS X

? Limitation

O If you use Mac OS X, this functions cannot be used.

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ From the pop-up menu, select [Job/Log].
B Select [Locked Print] from the [Job Type] pop-up menu.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumer-
ic (a-z, A-Z, 0-9) characters. Then enter a four-digits password in [Password].

& Note
O This is used to identify the user associated with a job.

B After making all of the settings you want, click [Print].
The document file is saved in the machine.
If you want to print this document, go to step 3.
If you want to delete this document, see p.25 “Deleting a Locked Print File”.

(3 on the machine's control panel, press the [Printer] key to display the Printer
screen.
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[ press [View Locked Print jobs].

1 Paper Tray Status 18 D[2e ofse o4 o] v
Ad [ A3 [8x11|8%x14 | 8%e11

> Sample Print Locked Print

| View Sample Print jobs. 11 Wiew Locked Prift jobs

3333 05/22 13:20 1

i [ 572 1320 7 "
——

The date and time when the job was sent from the computer, as well as the
User ID is displayed.

B Select the file you want to print by pressing it.

& Note
(3 Press [APrev.] or [¥Next.] to scroll the list.

O To cancel a selection, press the highlighted file again.
O Only one file can be selected at a time.

g Press [Print].

The password screen is displayed.

@ Enter the password with the nurnber keys, then press [OK]

m Enter the password using the number keys, and then press [OK].
The print confirmation screen is displayed.

@ Note

O The confirmation screen will reappear when the password has not been en-
tered correctly. Press [OK] to enter the password again.
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m Press [Yes].
The locked print file is printed.

ﬂlmportant
O When printing is completed, the stored file will be deleted.

& Note
O Press [No] to cancel printing.

O If printing is stopped by pressing [Job Reset] after printing has started, the
file will be deleted.

Deleting a Locked Print File

If the printed document is not what you expected, you can delete the locked
print file.

B on the machine's control panel, press the [Printer] key to display the Printer
screen.

g Press [View Locked Print jobs].
A list of the files stored on the machine is displayed.

B Select the file you want to delete by pressing it.

& Note
(3 Press [APrev.] or [¥Next.] to scroll the list.

O To cancel a selection, press the highlighted file again.
O Only one file can be selected at a time.

B press [Delete].
The password screen is displayed.

B Enter the password using the number keys, and then press [OK].
The Delete Confirmation screen is displayed.

@ Note

O The confirmation screen will reappear when the password has not been en-
tered correctly. Press [OK] to enter the password again.

[ press [ves).
After the file has been deleted, the screen returns to the Printer screen.

& Note
O When canceling the delete request, press [No].
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Document Server

Follow the procedures below to print a document using the “Document Server”
function.

& Note
O An optional hard disk drive is required to use the Document Server function.

Windows 95/98/Me

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

g Open the Printer Properties.

B Click to select the [Setup] tab.

ﬂ Select [Document Server] in the [Job Type] box.
B ciick [Details].

E Enter a user ID, file name or password in the dialog box that appears. These
are optional.

1 click [0k

B Start printing from the application's print dialog box.

Windows 2000/XP, Windows NT 4.0

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ Open the Printer Properties.

@ Note

O Under Windows 2000, the Printer Properties has already appeared togeth-
er with the print dialog box. Under Windows XP, open the Printer Prefer-
ences.

B Click to select the [JoblLog] tab.
O select [Document Server] in the [Job Type] box.

B Enter a user ID, file name or password in the dialog box that appears. These
are optional.

A ciick [0k

26 ﬂ Start printing from the application's print dialog box.
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Mac OS/Mac OS X

? Limitation

O If you use Mac OS X, this functions cannot be used.

ﬂ From an application, select [Print] from the file menu.
The print dialog box appears.

ﬂ From the pop-up menu, select [Job/Log].
B From the [Job Type] pop-up menu, select [Document Server].

ﬂ Enter a user ID, file name or password in the dialog box that appears. These
are optional.

B Start printing from the application's print dialog box.

27
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Printer Utility for Mac

By using the Printer Utility for Mac, you can download fonts, change the name
of the printer and so on.

? Limitation

O If a Macintosh and printer are connected by USB (option), you cannot use
Printer Utility for Mac.

& Note
O The Printer Utility for Mac is included on the CD-ROM labeled “Printer Driv-
ers and Utilities”.

O The Printer Utility for Mac requires Mac OS 8.6 ~ 9.x (Mac OS X 10.1 is sup-
ported.)

Installing the Printer Utility for Mac

Follow these steps to install the Printer Utility for Mac on the machine.
ﬂ Start the Macintosh.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The icon of the CD-ROM appears.

B Double-click the icon of hard disk to open it.

ﬂ Double-click the CD-ROM icon.
The contents of the CD-ROM are displayed.

B pouble-click the [Mac 0S 8 and 9] folder.

& Note
3 Under Mac OS X, Double-click the [Mac OS X] folder.

E Double-click the [PS Utility] folder of the CD-ROM, and then drag the
“Printer Utility for Mac” file and drop it into the Macintosh hard disk.

ﬂ Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
The Printer Utility for Mac is installed.
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Starting the Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Mac OS

ﬂlmportant
O Before starting the Printer Utility for Mac, make sure that the printer is select-
ed with [Chooser] on the Apple menu.

ﬂ Double-click the icon of the Printer Utility for Mac.
The Printer Utility for Mac dialog box appears.

B click [0k,
The Printer Utility for Mac will take a few seconds to start.

pe Reference
For more information, see p.30 “Functions in the Printer Utility for Mac”.

Mac OS X

ﬂ Double-click the icon of the Printer Utility for Mac.
The Printer Utility for Mac dialog box appears.
B cick [0k,
B From the [Available Printers:] box, select the printer you want to use.

& Note
O If you change zones, select a name from [Available Network Zones:].

O Click [Choose Printer..] on the Printer Utility for Mac menu if you want to
change the printer.

ﬂ Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

pe Reference
For more information, see p.30 “Functions in the Printer Utility for Mac”.
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Functions in the Printer Utility for Mac

The functions in the Printer Utility for Mac are described below.

< Apple menu (Mac OS), Printer Utility for Mac menu (Mac OS X)

[About Printer Utility for Mac...]
[Choose Printer...]

Display the Choose target printer dialog box.

* File menu

[Download PS Fonts]

Downloads fonts (PostScript Type 1) to the machine. = p.31 “Download-
ing PS Fonts”

[Display Printer's Fonts]

Displays and deletes the fonts in the machine's memory and the machine's
hard disk drive. = p.32 “Displaying the Machine's Fonts”

[Initialize Printer's Disk]

Initializes the machine's hard disk drive. = p.33 “Initializing the Hard
Disk”

[Page Setup]

Sets up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. = p.33 “Page Setup”

[Print Fonts Catalog]

Prints the names of available fonts. = p.33 “Printing the Font Catalog”
[Print Fonts Sample]

Prints a sample of fonts. = p.34 “Printing Font Samples”

[Rename Printer]

Changes the machine's name when viewed via Appletalk. = p.34 “Renam-
ing the Machine”

[Restart Printer]
Restarts the machine. = p.35 “Restarting the Machine”

+ Utility menu

[Download PostScript File]
Downloads a PostScript file. = p.35 “Downloading PostScript Files”

[Select Zone]
Changes the zone the printer belongs to via Appletalk. = p.36 “Selecting
the Zone”

[Display Printer Status]
Displays the status of the printer. = p.36 “Displaying the Machine Status”

[Launch Dialogue Console]
Creates and edits a PostScript file, and downloads it to the printer. = p.37
“Launching the Dialog Console”
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

#¥important

O The following procedure to download the fonts assumes that you are a sys-
tem administrator. If you are not, make sure to consult your system adminis-
trator.

O Resetting the machine causes the fonts to be deleted.

O Make sure that the Macintosh computer and the machine are connected in the
Appletalk environment.

& Note
O Some fonts cannot be downloaded.

O Before downloading, read the documentation of the fonts you want to use.
ﬂ Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

B Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

& Note
3 You can select [Printer's Disk].

B Click [Download].
The fonts are downloaded, and the download status is shown.

ﬂlmportant
O During the download, do not turn off the main power switch, operate the
panel, or open or close the cover.

B After the completion message appears, click [OK].
ﬂ Click [Cancel].
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Displaying the Machine's Fonts

You can view the available fonts currently downloaded into the machine. Fonts
in the machine's memory and hard disk can be displayed.

ﬂ Select [Display Printer's Fonts...] on the [File] menu.
The dialog box appears.

ﬂ Select [Printer's memory] or [Printer's disk].
B click [0k,

Deleting Fonts

You can delete fonts from the machine's memory or hard disk drive.

ﬂ Select [Display Printer's fonts] on the [File] menu.
The dialog box appears.

g Select [Printer's memory] or [Printer's disk].
B Select the fonts you want to delete.

? Limitation

O You cannot delete fonts displayed in Italics.

ﬂ Click [Delete].
A confirmation message appears.

B Make sure that the fonts you want to delete and the printer name from
which you want to delete the fonts are correct.

E Click [Continue] and then click [OK].
t crick k1.
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Initializing the Hard Disk

When initializing the machine's hard disk using the Printer Utility for Mac, only
the fonts related to PostScript will be deleted. Before initializing, make sure to
have an idea of the fonts that are already stored in the machine.

i@klmportant

O When initializing the machine's hard disk from the machine's control panel,
all the data in the machine, such as the document server data, will be deleted.
Before initializing, make sure to check the data on the hard disk drive.

ﬂ Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

& Note
3 To cancel initialization, click [Cancel].

g Click [Execute].
Initializing starts.

ﬁ*lmportant
O Do not turn off the main power switch until initialization is completed,

otherwise it might damage the hard disk drive.

B When the completion message appears, click [OK].

Page Setup

You can set the paper size in the “Print Fonts Catalogue” and “Prints fonts Sam-
ple”.

ﬂ Select [Page Setup...] on the [File] menu.
ﬂ Choose the paper size.

Printing the Font Catalog

You can print the names of fonts available on the machine.

? Limitation

O If you use Mac OS X, this function cannot be used.

& Note
O The paper selected under [Page Setup] is used.

ﬂ Select [Print Fonts Catalogue] on the [File] menu.
g Click [Print].
33
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Printing Font Samples

You can print samples of fonts that have been downloaded into the hard disk
drive and into the memory.

? Limitation

O If you use Mac OS X, this function cannot be used.

& Note
O Printing will be done by using the paper selected on [Page Setup].

ﬂ Select [Print Fonts Sample...] on the [File] menu.
B ciick [print.

Renaming the Machine

You can change the machine's name displayed under Appletalk. If you connect
several printers on the network, assign different names so you can identify them.
If several printers have the same name, a digit appears next to the machine name
in [Chooser].

ﬂ Select [Rename Printer...] on the [File] menu.

g Type a new name in the [New Name:] field.

? Limitation

O You can enter up to 31 digits and letters.

L Y/ AT A Ve II@// “"__rm
4 4

O Do not use symbols, for example “*”, “:”, “=

B Click [Rename].
The machine name is changed.

ﬂ Press [OK].
B Select [Chooser] on the Apple menu.
[ Click the icon of [AdobePS].

ﬂ Click to select the machine name renamed in step fJ, and then close [Choos-
er].

& Note
O If there are several Appletalk zones, select the zone the machine belongs to.
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Restarting the Machine

You can restart the machine from the file menu; however, the fonts in the ma-
chine's memory will be deleted.

ﬂ Select [Restart Printer] on the [File] menu.

ﬂ Acknowledge the message that appears on the screen, and then click [Re-
start].

The machine restarts.

& Note

O If the machine is restarted, all the settings return to their defaults. For set-
ting each function, see Printer/Scanner Unit Type 2045 Printer Reference 2
provided as a PDF file on the CD-ROM labeled “Operating Instructions for
Printer / Scanner”.

Downloading PostScript Files

You can download PostScript files for printing.
ﬂ Select [Download PostScript File...] on the [Utility] menu.
ﬂ Select the file name to print and click the file name, and then click [Open].

B Type the log file name, and then click [Save].
The selected file is printed.

& Note
O Errors are recorded in the log file.
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Selecting the Zone

You can change the zone the machine belongs to under Appletalk.

ﬁ*lmportant
O Make sure that the machine and the Macintosh computer are connected in the
Appletalk environment.

B select [Select Zone...] on the [Utility] menu.
The zone the printer belongs to and the available zone list appear.

gSelect the zone that you want to switch the printer to and then click
[Change].

A confirmation message appears.

B Click [Continue].
A confirmation message appears.

ﬂ Press [OK].

B Select [Chooser] on the Apple menu.

[ lick the [AdobePs] icon.

ﬂ Select the zone changed in step ] on [Appletalk zone:].

B Click to select the machine you want to use on [Select a PostScript Printer:].

g Close [Chooser].

Displaying the Machine Status

You can display the current status of the machine.

ﬂ Select [Display Printer Status...] on the [Utility] menu.
The current status of the machine appears.

ﬂ Check the current status of the machine.

You can check the memory capacity, the VM space, the hard disk drive status
and available space on the hard disk drive. You can also see the zone the ma-
chine belongs to.

B click [0k,
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Launching the Dialog Console

You can create and edit PostScript file for printing, and download it to the ma-
chine.

ﬂlmportant

O As the “Launch Dialogue Console” is recommended for users who have a
firm grasp of PostScript, it is advised that you take extreme care when oper-
ating it.

O Do not download any file other than PostScript files to the machine.

ﬂ Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

g Type the PostScript command in the editor screen.

& Note
O To edit a PostScript file, select [Open] on the [File] menu to open it.

O You can search or replace a character string by using the [Search] menu.

B After editing the PostScript file, select [Download Top Window] on the [Con-
sole] menu to start printing.

The PostScript file is sent to the machine.
ﬂ Printing is executed according to the transmitted PostScript file.

& Note
O [Reply from Printer] may open, depending on the PostScript file you sent.

B Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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